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  The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license. This means you can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute the work to the original author in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine') and the URL www.fullcirclemagazine.org (but not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If you alter, transform, or build upon this work, you must distribute the resulting work under the same, similar or a compatible license. Full Circle magazine is entirely independent of Canonical, the sponsor of the Ubuntu projects, and the views and opinions in the magazine should in no way be assumed to have Canonical endorsement.


  
    Please note: articles in this magazine are provided with absolutely no warranty whatsoever; neither the contributors nor Full Circle Magazine accept any responsibility or liability for loss or damage resulting from readers choosing to apply this content to theirs or others computers and equipment.
  


  Welcome to another issue of Full Circle.


  It's a full house this month. Greg and Elmer bring you Python and LibreOffice, and are joined by a lengthy article on installing Linux Mint (or any *buntu for that matter) on a Raid 0 system, and a quick look at the Top command. As ever, Mark is here with Inkscape too.


  Starting this month is a Linux Labs series on how I built my RepRapPro Fisher 1 3D printer. It took me a full weekend of double-checking everything ('measure twice, cut once' as the old saying goes). Amazingly, it worked first time and is a great printer. I estimate the series to be in at least four parts. I'm not going into every step of the build (as all the instructions are online) but touching on the main points, and the little things to look out for. In tandem with that piece, my Arduino article is briefly discussing the Arduino compatible Duet board that controls the Fisher 3D printer.


  If privacy and security are what you need, then this month's Security and Chrome Cult articles are a must. S.J. looks at encryption in the ChromeOS on a Chromebook, and the Security piece shows you how to create an encrypted drive with VeraCrypt.


  Last, but not least, we have a couple of book reviews. Just in case you happen to have a quiet moment over the holiday season.


  

  All the best, and keep in touch!


  

  Ronnie

  ronnie@fullcirclemagazine.org


  NEWS
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  Cisco Evolves IOS XR Network Operating System with Linux


  At the core of Cisco's big routers has long been the IOS-XR network operating system. IOS-XR is now evolving, thanks to a rebasing on Linux and the inputs of Cisco's hyperscale web partners. Kevin Wollenweber, director of product management for Cisco’s service provider segment, explained that the new IOS-XR 6.0 release provides improved visibility into a network with a feature called telemetry. Wollenweber explained, that in the past, many network devices used old approach such as SNMP traps that probe a network in order to get information.


  "What we've done with telemetry is we have built a publisher/subscriber model where devices push out information at regular intervals," Wollenweber said.


  Additionally IOS-XR provides more programmability to enable a higher degree of network automation. Technologies such as puppet and chef for orchestration are now also enabled for automation.


  "We built an infrastructure that allows people to run their own applications in Linux containers on the router itself," Wollenweber said.


  Cisco is using Linux Containers (LXC) as the container technology. Wollenweber explained that IOS-XR is now based on a Linux infrastructure, which is what enables more toolchains and standard interfaces.


  Source: http://www.enterprisenetworkingplanet.com/netos/cisco-evolves-ios-xr-network-operating-system-with-linux.html

  Submitted by: Arnfried Walbrecht

  


  AMD Crimson Driver Downgrades Performance on Linux


  Recently, AMD claimed that the company will provide over a 100% performance boost in some Linux games via the Crimson Driver. The stats they showed were impressive so we expected Linux performance to improve. AMD shared a few slides which showed 112% performance boost in Bioshock Infinite, 113% in DOTA and a staggering 155% in Total War.


  But is the performance actually as good as they claim? While Windows users look pretty happy about Crimson and the optimizations it brought, how does AMD users feel about this? Actually it downgrades performance compared to AMD Catalyst 15.9. AMD really dropped the ball on this one and once again Linux players screwed over.


  It looks like AMD Crimson Driver is not the way to go for Linux users, so they better stick with Catalyst for now. Well, at least until AMD fixes this problem.


  Source: http://techfrag.com/2015/11/28/amd-crimson-driver-downgrades-performance-on-linux/

  Submitted by: Arnfried Walbrecht

  


  Some Raspberry Pi Devices Have Predictable SSH Host Keys


  Raspberry Pi devices running on Raspbian may need to be patched to avoid a security issue that results in the device generating weak and predictable SSH keys. Raspbian is a free operating system based on Debian optimized for Raspberry Pi hardware. According to developer oittaa, the issue resides in the way Raspbian generates SSH keys.


  "As soon as the systems starts up, systemd-random-seed tries to seed /dev/urandom, but /var/lib/systemd/random-seed is missing, because it hasn't been created yet," explains the developer. "/etc/rc2.d/S01regeneratesshhost_keys is executed, but /dev/urandom pool doesn't have that much entropy at this point and predictable SSH host keys will be created," he continues.


  Source: http://news.softpedia.com/news/some-raspberry-pi-devices-have-predictable-ssh-host-keys-496864.shtml

  Submitted by: Arnfried Walbrecht

  


  Ubuntu GNOME 15.10: The perfect Linux desktop distribution


  For the longest time I'd been heralding Ubuntu and its Unity desktop as one of the best Linux distributions. I liked Unity… a lot. The design was beautiful, and workflow about as efficient as you would ever find. The Dash, the Launcher, the HUD… they all came together in a perfect storm of form and function.


  But then things seem to sour a bit. First the releases seemed to offer little to no improvements. With the developers working desperately to bring to life the next iteration of Unity (Unity 8/Mir), it seemed the desktop, as it stood, had become an afterthought. During that time, something very, very interesting happened.


  Ubuntu GNOME 15.10. It is everything vanilla Ubuntu should have been from the start. It's what every Linux desktop environment should aim to be. In fact, this was the first time, since I've been using Linux, that I completed an installation of a distribution and actually struggled to find a necessary tweak.


  Source: http://www.techrepublic.com/article/ubuntu-gnome-15-10-the-perfect-linux-desktop-distribution/

  Submitted by: Arnfried Walbrecht

  


  Linux Foundation adds Open Networking Summit to event portfolio


  The Linux Foundation is adding the Open Networking Summit to its event portfolio beginning with the next show scheduled for March 14 in Santa Clara, California.


  The ONS was initially started by companies focused on software-defined networking technologies to enable collaboration efforts centered on SDN, OpenFlow and network functions virtualization. Those events have seen collaborative efforts announced from the likes of AT&T, Google and the Linux Foundation.


  “Open source SDN and NFV are the future of networking and future of our industry. Transitioning ONS to the Linux Foundation allows ONS to build on its successes as the premier event shaping the future of SDN and NFV to help grow the community and accelerate adoption of open source SDN and NFV by network operators and vendors,” said ONS Chair Guru Parulkar. “The ONS team looks forward to working with the Linux Foundation team to make 2016 a resounding success.”


  Source: http://www.rcrwireless.com/20151201/telecom-software/linux-foundation-adds-open-networking-summit-to-event-portfolio-tag2

  Submitted by: Arnfried Walbrecht

  


  Google's killing Chrome support for 32-bit Linux, Ubuntu 12.04, and Debian 7


  If you purchased your computer in the last decade, it probably has a 64-bit-capable processor. The transition to 64-bit operating systems has been a long one, but Google is about to give Linux users another push. In March 2016, Google will stop releasing Chrome for 32-bit Linux distributions. In an update posted to the Chromium-dev mailing list, Google’s Dirk Pranke wrote:


  “To provide the best experience for the most-used Linux versions, we will end support for Google Chrome on 32-bit Linux, Ubuntu Precise (12.04), and Debian 7 (wheezy) in early March, 2016. Chrome will continue to function on these platforms but will no longer receive updates and security fixes.


  We intend to continue supporting the 32-bit build configurations on Linux to support building Chromium. If you are using Precise, we’d recommend that you to upgrade to Trusty.”


  Source: http://www.pcworld.com/article/3010404/browsers/googles-killing-chrome-support-for-32-bit-linux-ubuntu-1204-and-debian-7.html

  Submitted by: Arnfried Walbrecht

  


  Microsoft brings Debian GNU/Linux to Azure cloud


  Microsoft has collaborated with credativ to offer Debian GNU/Linux as an endorsed distribution on its Azure cloud. Microsoft already had ties with SUSE and Canonical to offer openSUSE, SLE and Ubuntu on Azure cloud. It also had deals with OpenLogic to offer Red Hat’s CentOS. And after a very long wait, Microsoft struck a deal with Red Hat to bring RHEL to its cloud. That left Debian, one of the most popular GNU/Linux distributions on servers, behind. Until now. Customers can now easily provision Debian-based virtual machines in Microsoft Azure. There are two supported versions of Debian available for Azure: Debian 7 (codename “wheezy”) and Debian 8 (codename “jessie”), both built by credativ.


  Passionate Linux fans may criticize Microsoft for being hypocritical: at one hand they display their love for Linux, and on the other hand they continue with their patent attacks against Linux players.


  There is actually no hypocrisy here. It’s pure business.


  Source: http://www.itworld.com/article/3011419/operating-systems/microsoft-brings-debian-gnu-linux-to-azure-cloud.html

  Submitted by: Arnfried Walbrecht

  


  Can We Save Wireless from Regulators?


  Linux was born and grew within an ecosystem of norms, not laws. Those norms were those of programming (C), operating systems (*NIX), command shells (bash, etc), e-mail (SMTP, etc), licenses (GPL, etc), and Internet protocols (TCP/IP and the rest).


  Had Linux and the Internet been left up to the world's big operating system and network providers, we never would have had either one. Instead, we would have had what business giants and their captive regulators are inclined to believe what both actually are: "intellectual property" and billable "services".


  "Free" and "open" are the adjectives that best describe the development ethos that allowed Linux and the Internet to happen. Yes, there were regulations around, but Linux and the Net grew up outside the scope of what Bob Frankston calls The Regulatorium. To a blessed degree they still do, but that degree is getting narrower and less blessed as more of our computing and communicating moves to mobile devices.


  Source: http://www.linuxjournal.com/content/can-we-save-wireless-regulators

  Submitted by: Arnfried Walbrecht

  


  Apple open sources Swift and makes a Linux port available


  You no longer need a Mac computer to build apps using Apple's newest code platform: Apple made its Swift programming language open source on Thursday, just as Google has done for Dart. The company introduced Swift as a surprise during its 2014 Worldwide Developers Conference. Until then Apple's Xcode IDE and Objective-C was used to create all Apple apps. A year later, Apple surprised again by promising to open source the Swift platform this year.


  By opening up the platform beyond the confines of Cupertino, Apple expects others to contribute to the Swift language as it matures. Along with the open source launch, Apple has already published a Swift port for Linux computers. To use the Linux port, you'll need an x84, 64-bit computer, and use either the source code to build Swift yourself or download pre-built binaries for Ubuntu. Apple says the port is a work in progress, but useful to experiment with Swift on a Linux machine.


  Source: http://www.zdnet.com/article/apple-open-sources-swift-and-already-makes-a-linux-port-available/

  Submitted by: Arnfried Walbrecht

  


  Linux Foundation: Shaping our software-defined future


  Over the past decade, Linux has gone from scrappy insurgent to mainstream choice for the enterprise data center. Linux has ruled the cloud from the beginning, and while it flopped on the desktop, it has an 83 percent share of smartphones in the form of Android, which is built on the Linux kernel. Plus, Linux pretty much owns the embedded market, from TVs to cars to new IoT devices.


  Jim Zemlin, executive director of the Linux Foundation, has watched these triumphs up close during his 10-year tenure with the organization. During that time, the Linux Foundation has quietly expanded to encompass 26 collaborative projects, including such marquee ventures as Cloud Foundry, Node.js, OpenDaylight, and Xen.


  The Linux Foundation also puts on dozens of live events, including the Apache Software Foundation’s conferences, and runs a booming training business. For example, says Zemlin, hundreds of thousands of aspiring admins take Linux courses offered by the Foundation on edX for free.


  Source: http://www.infoworld.com/article/3012253/linux/linux-foundation-shaping-our-software-defined-future.html

  Submitted by: Arnfried Walbrecht

  


  The insecurity of platforms and how open source overcomes it


  All platforms are insecure. They can all be exploited in one way or another. At some point in time, it will be announced that no operating system is invulnerable and every single one of them has their kryptonite. Every. Single. One.


  Windows. OSX. Linux. Android. iOS. None of them are one hundred percent safe. Plug them into a network and their security is compromised. It doesn't matter how well the platform is designed, there will be those up to the challenge of taking it down.


  However, there is one platform that is better suited for overcoming that which ails the flawed ones and zeros. One platform that is not only adept and agile enough to run toe-to-toe with entropy and infiltration… one that can overcome.


  Source: http://www.techrepublic.com/article/the-insecurity-of-platforms-and-how-open-source-overcomes/

  Submitted by: Arnfried Walbrecht

  


  Open Container Initiative Finds Footing In Linux Foundation


  The Open Container Initiative, which was formed last June to set the future direction of container technology, has established its self-governance and new status as a collaborative project of the Linux Foundation, as of December 8. In an interview with InformationWeek, Docker's lead representative to the initiative, Patrick Chanezon, chief developer advocate, said creating a self-governing body was crucial to maintaining cooperation among the competing members of the initiative. The membership of the initiative believes that standardizing the base technology will allow a spirited competition to emerge in the areas of innovating tools, management services, and new applications on top of the core elements. The initiative is a welcome addition to the Linux Foundation's collaborative project ecosystem, Zemlin noted.


  Source: http://www.informationweek.com/open-container-initiative-finds-footing-in-linux-foundation/d/d-id/1323439

  Submitted by: Arnfried Walbrecht

  


  Linux smartphones took a serious step back in 2015


  2015 was such a hopeful year for Linux on smartphones. At the beginning of the year, there was so much hope for what could be. The promise of Ubuntu Touch being available on shipping devices was alluring. FirefoxOS phones were already shipping… and the future was looking bright. And Jolla was gearing up for a new iteration of their Linux-powered OS, along with a shiny new tablet to go with it.


  Then – at the #mozlando conference on Tuesday, December 8th – Mozilla announced that they would no longer be working with carriers to ship Firefox OS phones. Mozilla issued the following statement, via TechCrunch:


  "Firefox OS proved the flexibility of the Web, scaling from low-end smartphones all the way up to HD TVs. However, we weren't able to offer the best user experience possible and so we will stop offering Firefox OS smartphones through carrier channels."


  This is definitely sad news for those looking forward to a free system for their smartphones. But the onslaught of bummer-inducing news doesn't end there. Jolla, the company behind Sailfish OS, is having some serious problems… including layoffs. The company is now, according to Antti Saarnio (Jolla Chairman of the Board), "fighting for its survival."


  Source: http://www.networkworld.com/article/3013493/opensource-subnet/linux-smartphones-mozilla-firefox-os.html

  Submitted by: Arnfried Walbrecht

  


  Adobe Releases Massive Security Update for Linux Flash Player


  Adobe abandoned active development for the Flash Player on Linux a while back and is now only releasing security upgrades. The company just released a massive security update, and it looks like the Linux platform is covered as well.


  Flash is so well embedded on the Internet that it's really difficult to get rid of. Despite being shunned by all the major players like YouTube, Facebook, Apple, and pretty much everyone else, it's still present all over the place. That means that all the security problems are still present, and they need to be dealt with.


  The Flash Player for Linux has been stuck at version 11.x for many years, and it's not going to advance. It will stay in that branch until it is declared dead, but, from time to time, Adobe remembers that there are Linux users as well and that they might be affected.


  Source: http://news.softpedia.com/news/adobe-releases-massive-security-update-for-linux-flash-player-497360.shtml

  Submitted by: Arnfried Walbrecht

  


  'Fairly bad core bug' crushed in Linux 4.4-rc5


  Linux Lord Linus Torvalds says the fourth release candidate of Linux 4.4 contained “a fairly bad core bug” that's since been squashed, but may not have rung many alarm bells anyway. “Another week, another rc,” Torvalds writes on the Linux Kernel mailing list, before going on to say that development work is progressing as usual save for “... a fairly bad core bug that was introduced in rc4 that is now fixed in rc5”.


  Torvalds declares that bug “a bit embarrassing” but added “I don't think that many people actually ever hit the problem.”


  Problem? What problem? Maybe this was the problem.


  Torvalds' next problem is deciding when to schedule the release of version 4.4. He's tossing up pausing things for a week to let people enjoy the season, or proceeding at the usual pace and waiting a week before opening the version 4.5 merge window.


  Source: http://www.theregister.co.uk/2015/12/14/fairly_bad_core_bug_crushed_in_linux_44rc5/

  Submitted by: Arnfried Walbrecht

  


  Dell and Red Hat Deliver Easier Firmware Updates for Linux Users


  Dell -- the first big company to sell Linux computers -- is catering to open source fans again by announcing plans to make user-friendly firmware upgrades possible on Linux.


  In a blog post, Richard Hughes, who works for Red Hat (RHT) and contributes to the GNOME project, writes that Red Hat and Dell have been collaborating on a system that will allow users of Dell hardware to update firmware from Linux. If that doesn't seem significant to you, it's probably because you either do not use Linux or have not spent enough of your life geeking out to know what firmware is. For a long time, most major hardware companies have offered tools that make it possible to update firmware from Windows by relying on some tricks that allow the firmware to change without crashing the system. But none of these tools has been available for Linux. Instead, Linux users have had to rely on the archaic method of booting to rescue partitions or special CDs to update firmware.


  The new support for firmware updates from Dell will change this. Now, Linux users can upgrade firmware from the comfort of their production desktop environments.


  Source: http://thevarguy.com/open-source-application-software-companies/dell-and-red-hat-deliver-easier-firmware-updates-linux-us?utm_source=feedburner&utm_medium=feed&utm_campaign=Feed%3A+TheVarGuy+%28The+VAR+Guy%29

  Submitted by: Arnfried Walbrecht

  


  Core Developer Jeff Garzik on the Similarities Between Bitcoin and Linux


  Before making any contributions to Bitcoin, Bloq Co-Founder and Bitcoin Core Developer Jeff Garzik was a longtime Linux developer who started working on the operating system in the early nineties — before the creation of Red Hat. As someone who was involved in the early development of both Linux and Bitcoin, Garzik has a unique perspective on the common themes found in the two respective development communities. One of the key attributes of both Bitcoin and Linux development is both open-source platforms were originally maintained by volunteers. Garzik explained:


  “I see so many parallels between Bitcoin and Linux in that, in the early days of Linux, you had university students [and] professional engineers working in their spare time with this stuff. It was really very early stage early efforts, and with Bitcoin it is very much the same way.”


  Source: http://insidebitcoins.com/news/core-developer-jeff-garzik-on-the-similarities-between-bitcoin-and-linux/36223

  Submitted by: Arnfried Walbrecht

  


  Linux Foundation Drives Mass Innovation Through Open Source With New Members


  The Linux Foundation, the nonprofit organization enabling mass innovation through open source, today is announcing three new silver members are joining the organization: Autodesk, Concurrent Computer Corporation and DataKinetics. Thousands of developers and more than 600 organizations work across Linux Foundation-hosted projects. From container technologies and application platforms to datacenter operating systems and networking, The Linux Foundation provides critical services to support every corner of technology infrastructure. By growing the member ecosystem to include software solutions and big data processing experts, The Linux Foundation further unites the world's leading technologists to drive open innovation on a global scale.


  "Open source has become the de facto way to create software. The Linux Foundation provides a neutral home for organizations to develop technology at scale and at a rate that can't be matched working on their own," said Jim Zemlin, executive director, The Linux Foundation. "We're excited to welcome these members to our organization as we enter another exciting year of collaboration."


  Source:http://money.cnn.com/news/newsfeeds/articles/marketwire/1235311.htm

  Submitted by: Arnfried Walbrecht

  


  You Can Break Into a Linux System by Pressing Backspace 28 Times. Here’s How to Fix It


  Hitting a key over and over again actually works for once. Two security researchers in Spain recently uncovered a strange bug that will let you into most Linux machines just by hitting the backspace key 28 times. Here’s how to fix it and keep your data protected.


  The researchers, Hector Marco and Ismael Ripoll from the Cybersecurity Group at Polytechnic University of Valencia, found that it’s possible to bypass all security of a locked-down Linux machine by exploiting a bug in the Grub2 bootloader. Essentially, hitting backspace 28 times when the machine asks for your username accesses the “Grub rescue shell,” and once there, you can access the computer’s data or install malware. Fortunately, Marco and Ripoll have made an emergency patch to fix the Grub2 vulnerability. Ubuntu, Red Hat, and Debian have all issued patches to fix it as well.


  Source: http://lifehacker.com/you-can-break-into-a-linux-system-by-pressing-backspace-1748370796

  Submitted by: Arnfried Walbrecht

  


  Ubuntu 16.04 LTS won't send local searches over the web by default


  With Ubuntu 16.04 LTS, the OS will no longer send your local searches over the web by default. This will eliminate those obnoxious product search results from online stores, and should make the EFF and other organizations that criticized the practice happy. Even better, the change is being made to the classic Unity 7 desktop, not just the new Unity 8 desktop. Canonical, the maker of Ubuntu, previously announced that Unity 8 wouldn't send searches over the Internet by default, but currently that interface is used only on Ubuntu phones and experimental Ubuntu desktop images. Unity 8 won’t arrive as a PC desktop for quite some time. Ubuntu 16.04 LTS will feature a choice of desktop environments, and most Ubuntu users will likely stick with the stable Unity 7 desktop for years to come.


  Rather than make everyone wait for Unity 8 to get this change, Ubuntu’s developers are making Unity 7 a bit more like Unity 8 in Ubuntu 16.04 LTS.


  Source: http://www.pcworld.com/article/3015021/linux/ubuntu-1604-lts-wont-send-local-searches-over-the-web-by-default.html

  Submitted by: Arnfried Walbrecht

  


  Apple’s rumored display shift could push even more Android vendors to switch to OLED


  More and more reports indicate that Apple is looking to equip future iPhones with a new kind of display. According to multiple reports, Apple is going to use OLED screens starting with the high-end 2018 iPhone 8 models, and the company is reportedly in negotiations with the major OLED screen providers who also happen to be some of its top rivals in the smartphone business. On top of that, Apple is also working on its own screen technology at a secret lab in Taiwan, studying flexible displays and micro-LED technology.


  A new report out of Asia further reinforces the idea that Apple is determined to switch from LCD to OLED screens in future iPhones, suggesting that Apple’s efforts will also have a welcome side effect. Other smartphones, including Android handsets, might become better than ever as well starting next year.


  Source: http://bgr.com/2015/12/18/iphone-7-8-oled-android/

  Submitted by: Arnfried Walbrecht

  


  #


  Command & Conquer: Ubuntu Phone Webapps


  Lucas Westermann


  As promised last month, I’ll be covering some more ubuntu phone programming. While preparing for this article, I have looked at most of the tutorials from Ubuntu itself. They are well written, and definitely a good spot to start. I will focus on more general approaches - what app type to use for what purpose, as well as a small example of a web app.


  App Types


  
    	HTML5 app - this is a full-fledged HTML app. If you’re a web developer and want to create a specific HTML5 app for Ubuntu, you’ll want this.


    	Webapp - this is the app type you use to open an existing page, in order to run it like an app.


    	QML - A native app for Ubuntu (written in QML, which is the Qt Meta Language).


    	Scopes - These can be written in various languages, and combined with APIs.

  


  Webapp


  As an example, I’ll briefly cover how to create a webapp for opening the Full Circle Magazine site.


  
    	Create a new Webapp project


    	Open <appname>.desktop


    	Edit the exec line to read: Exec=webapp-container --enable-back-forward --store-session-cookies --webappUrlPatterns=https?://fullcirclemagazine.org/* http://fullcirclemagazine.org


    	Replace <appname>.png with a 128px x 128px icon (eg. the FCM circular logo).

  


  The important step is the third one. Here you indicate the allowed URL patterns - in this case we allow any https or http (https?://) connection to fullcirclemagazine.org, and its subpages (/*). This way, the site can be browsed. It’s possible to supply multiple patterns - for example for subdomains.


  As you can see - creating a basic webapp is extremely simple. If you want to connect an account, you can either log in via the web interface (as normal) by setting the login page to the default URL (last URL in the Exec line). If you want to use the OnlineAccounts API, you’ll apparently need to use a fully-fledged HTML5 app. If the site you’re connecting to also offers an API, using an HTML5 app (and asking for credentials in settings), you should be able to connect via API as well. See the examples on the Ubuntu page for more details.


  QML App


  I was planning on also including a QML app example here, but have faced various issues with translations and the make files required for compiling a QML app. Instead, I’m trying to fix the issues, so that I can hopefully cover QML apps in my next article.


  Questions for readers


  Are there any Ubuntu phone apps you can’t live without? Or maybe there’s a particular style of app you’re curious about. Send me an email, and I will see if I can’t include an answer in my next article.


  In general - is there something you’d like to see more of from me in 2016?


  All answers can be emailed to lswest34+fcm@gmail.com.


  I hope everyone’s had a good year, and thank you for reading C&C!


  Further Reading


  

  HTML5 apps: https://developer.ubuntu.com/en/apps/html-5/tutorials/

  Get started: https://developer.ubuntu.com/en/apps/qml/tutorials/building-your-first-qml-app/

  Webapp: https://developer.ubuntu.com/en/web/tutorials/

  QML Apps: https://developer.ubuntu.com/en/apps/qml/tutorials/

  Scopes: https://developer.ubuntu.com/en/scopes/tutorials/


  Python in the REAL World - Part 62


  By G.D. Walters


  By the time you read this, it will probably be old news that there is a new Raspberry Pi that was released on November 26, 2015. It's called the Raspberry Pi Zero and the price is an unbelievable $5 U.S. or 4₤. I haven't had a chance to find any actual dimensions, but they say it is about the size of a stick of gum. So if you've been holding off getting your new Pi due to cost, now you don't have an excuse. We will discuss the Pi Zero in future articles.


  Now back to my Physical Programming series. This time we are going to start actually controlling things. Hopefully, you have been able to procure some LEDs, resistors, switches, jumpers and a breadboard.


  As we go through the series, I will be using a free design tool called Fritzing to provide a visual representation of what the project wiring should look like.


  [image: OOPS]


  You might want to get yourself a copy from their website (http://fritzing.org/home/). Not only can you keep copies of our projects locally, you also can have some fun designing your own circuits.


  A Quick Discussion Of Our Components


  One more thing before we get started, which is a quick discussion on some of the electronic components we will be using this time, Resistors, LEDs and Switches.


  Resistors


  A resistor is a device that 'resists' the flow of electricity to a given extent. This will allow us to limit the amount of electricity that flows through a circuit or part of one. In the case of the LED projects, we will be using resistors so that they will reduce the amount of electricity flowing through the LED (and the GPIO pin), to keep it from burning out.


  For a more detailed discussion of resistors, please see: https://learn.sparkfun.com/tutorials/resistors.


  LEDs


  LEDs are Light Emitting Diodes and are the “standard” replacements for bulbs in just about everything. With a little care in design, they will last almost forever. An LED has two leads/wires called Anode and Cathode. The Anode is the positive side and the Cathode is the negative side.


  [image: OOPS]


  If you have a new LED directly out of the package, you will notice that one of the leads is longer than the other. That is the Anode or the positive side. If both leads on a new device are the same length (or if you are recycling parts from an old circuit board), look for the flat edge. That will always show the Cathode or negative lead.


  Switches


  The switch I chose to use for this project is one that easily mounts in the breadboard or on a circuit board. It is simply square with a small round momentary button on the top. It also has 4 pins. The trick is to know which two pins of the four will be the ones we need. You could take an ohm-meter and run across all the combinations of pins until you find the set that works, or you could just look at the layout of the pins that connect it to the breadboard. The two pins to be used have the leads that grip into the board pointing at each other. You only need one set of pins, so just pick the set you wish.


  Our First Project...


  Now let's get started with our first construction project. It's a very simple electronics version of “hello world”. We will connect a switch to one of the GPIO pins and monitor it to catch the press of the button.


  Here is the actual schematic that we will be working with.


  [image: OOPS]


  So we have a switch that is connected between ground pin and GPIO pin 17 which is physical pin 11. We also have an LED connected with its cathode to GPIO pin 18 (physical pin 12) and its anode connected to a resistor that connects to the 3.3volt pin on the Pi. It is at this point that you need to make a decision. Will you reference the pins by their position on the board, or the GPIO numbers. We'll get back to that in a minute. In the meantime, here's the wiring diagram…


  [image: OOPS]


  You can see on the breadboard the three components...the switch, the LED and the resistor. The first pin on the RPi is the one on the top right. That pin provides the 3.3 volts DC that we need to power our project. The pin below it is counted as pin #2. Pin #6 is a ground pin. Note that both of those pins have wire connectors that go to the long horizontal buses on the breadboard. Some breadboards have a “+” and “-” on the power bus to help you remember which bus is which. I also have a long jumper from the positive 3.3 volt bus at the top of the breadboard down to the bus on the bottom. It really doesn't matter which bus on the breadboard you use for your power, as long as you are consistent.


  There is a short jumper going from the top ground bus to one side of the switch and the other side of the switch connects to physical pin 11 on the RPi (or GPIO pin 17). As for the LED, the Cathode is connected to the physical pin 12 on the RPi (GPIO 18) and the Anode is connected to the resistor, which in turn is connected to the lower 3.3 volt bus. Also notice that the wiring is colour coded. Red will ALWAYS (in my diagrams) be a positive voltage, Black is for ground. Any other colors will mean interconnections for data.


  If you have been keeping up so far, you will notice that I am giving both the physical pin number as well as the BCM GPIO pin number. The “BCM” stands for Broadcom, and, in our code, we will have to tell the RPi.GPIO library if we are using board numbering or BCM numbering. This is the decision I was referring to earlier. In our code, we will have to be consistent with one numbering scheme or the other. In the code we are about to look at, I provide both, and you can comment out whichever one you don't want to use. My personal preference is to use the BCM GPIO numbers, but for this project, I will stick with the physical board pin numbers. Now let's get into the code.


  
    
import RPi.GPIO as GPIO

# If you are using the BCM GPIO pin numbers...
#LedPin = 18
#BtnPin = 17
# Otherwise the physical board numbers...
LedPin = 12
BtnPin = 11


  


  As always, I will break the code into parts and discuss each one. First we have to import the RPi.GPIO library, and we will alias it to the name “GPIO” to make things easier to type. Next, we define two variables; LedPin and BtnPin to the pin numbering scheme we wish to use. Here, I've decided to use the Physical pin numbering, since you probably don't have a breakout wedge yet. I've found the one from SparkFun to be very nice, but it gives you only the BCM numbers on the pins. Our next bit of code will be a function called “setup”, where we set up the information for the library to use.


  
    
def setup():
    #GPIO.setmode(GPIO.BCM)
    GPIO.setmode(GPIO.BOARD)
    GPIO.setup(LedPin, GPIO.OUT)
    GPIO.setup(BtnPin, GPIO.IN,pull_up_down=GPIO.PUD_UP)
    

  


  Notice that the first line is commented out since I will be using the board numbering in this example, but it's there to show you how to make the call. Lines 3 and 4 show how to define what the pins will be, either input or output, and if we use the internal pull up resistors built-in on the RPi or not. So basically this portion of the code says to use physical board pin numbers as references, and it defines the Output pin to drive the LED and the pin that the signal from the button will be coming in on. Also notice that we define the pin for the button to have a pull-up resistor. This means that the signal-line will be at 3.3 volts and when the button is pressed it is pulled down to ground.


  
    
def loop():
    while True:
        if GPIO.input(BtnPin) == GPIO.LOW:
            print('...LED On')
            GPIO.output(LedPin,GPIO.LOW)
        else:
            print('...LED Off')
            GPIO.output(LedPin,GPIO.HIGH)
            

  


  Our next function is called loop, and, as the name suggests, we simply do a loop, checking the button input pin to see if it has been pulled low. If it has, then we turn the LED on, otherwise we set the LedPin to high. That might sound counter-intuitive, but remember we have the Anode connected to the 3.3 volt bus through the resistor. This means to turn the LED on, we have to pull the Cathode down to ground (0 volts) level to allow the LED to turn on.


  
    
def destroy():
    GPIO.output(LedPin,GPIO.HIGH)
    GPIO.cleanup()
    

  


  The destroy function basically cleans up the states of the pins so we don't get any errors the next time we need to use them.


  
    
if __name__ == '__main__':
    setup()
    try:
        loop()
    except KeyboardInterrupt:
        destroy()


  


  Finally, we use the “main loop” to call the routines in the proper order and to allow us an easy way to break out of the loop by pressing the Ctrl-C key sequence.


  So, load the program into your RPi and run it. You will notice the text “...LED Off” keeps repeating on the screen until you press the button. That is due to the fact that our loop routine reads the level or status of the button pin and once the voltage goes low, it says “oh...the button input is low, so I need to turn on the LED”.


  One other thing to notice is that our first and second routines are named “setup” and “loop”. It is a good thing to keep this format, because when we get to the Arduino programming, these two routines are required.


  We are going to stop here for this month. I want the other authors to have room for their articles. Keep everything close at hand, because we will be using the same hardware setup next time.


  Enjoy playing for now and I will see you next month.


  Greg


  LibreOffice, Part 55, Fontwork


  by Elmer Perry


  Have you ever been working on a document – let's say, a newsletter – and you wanted to format some fancy text? Bold, italic, and other standard formatting options were not enough. You wanted the text to have shape. You could load up GiMP or Inkscape, but wouldn't you rather do it directly in the document? Well, with Fontwork, you can. Fontwork is a tool in LibreOffice that allows you to “shape” text – bend and twist it at your will. No, it's not magic, but is so simple you'll swear it is. Okay, you shouldn't swear, but it's really cool.


  Fontwork is a tool you don't use every day. It is a special tool for special occasions. Fontwork, as the name suggests, is a tool to manipulate the font of your text, give it a shape, and maybe turn it into art. You start with the Fontwork Gallery by selecting a starting pattern. From there, you take your generic pattern and make it your own by changing the font, character spacing, shape, color, fill, and more. The Fontwork object becomes an object just like any other object in LibreOffice, and you can use all the object tools on it. Think of Fontwork as a drawing object made from text.


  Create a Fontwork Object
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  To create a Fontwork object, we need to access the Fontwork Gallery. There are two toolbars that contain a Fontwork Gallery button, the Fontwork toolbar (View > Toolbars > Fontwork) and the Drawing toolbar (View > Toolbars > Drawing). You can also access the Fontwork Gallery through the menus, Insert > Media > Fontwork Gallery. In the gallery, you see many different shapes of the text “Fontwork.” Select the shape that is close to what you want for a final product. Click OK.
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  Now, you have a Fontwork object, but the text is not the text you want, unless you are creating an ad for Fontwork. Double-click on the Fontwork object and the text will appear over the object. Here you can edit the text just as you would any text. You can use the tools in the formatting toolbar to change the font, bold, and italic, but, depending on the shape you chose, it may not have much effect on your results. However, as with anything, I encourage you to play with it. You never know what results you might get. The alignment tools have no effect as the Fontwork object has its own alignment tool as we will see later.


  A yellow dot appears in every Fontwork object. The dot’s location is different depending on the shape you have chosen for your text. If you hover over the dot, the pointer turns into a hand symbol. Click and drag the dot to adjust the effect of the shape of your text.


  The other eight dots around the object are called handles. You can drag these handles to resize the object. Resizing from the corners can help maintain the aspect ratio of the object, but if you need to squash or pinch the object to get the desired effect, then the four side handles are there as well.


  Fontwork Toolbar


  The Fontwork toolbar provides the basic tools for editing a Fontwork object. These tools allow you to further tweak the Fontwork object into the final product. You will want to try each tool to see how it affects your design.
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  Fontwork Gallery – opens the Fontwork Gallery.


  Fontwork Shape – if you change your mind about the shape you want, you can select it here without having to delete your object and select again from the gallery.


  Fontwork Same Letter Height – this makes all characters in the text the same height regardless of the case. Even if they are all lowercase, a lowercase e will stretch to the size of a lowercase h. The effect enhances many of the different shapes, and results will vary according to your text and desired results.


  Fontwork Alignment – this tool has no effect unless you have multiple lines in your text. Right, left, and center are pretty self-explanatory, but the one that can really give you some cool effects is the stretch justify. Stretch justify will stretch smaller words to fill the shape of the object.


  Fontwork Character Spacing – this setting controls the spacing between the individual characters in the text. The setting ranges from very tight (letters right against each other) through very loose (spread out). There is also a custom option where you specify a percentage of the character width.
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  Extrusion On/Off – this switches the 3D effect on and off. When on, you will see the 3D Settings toolbar. The 3D toolbar has settings for tilting up, down, left, and right; depth of the extrusion; the direction or perspective; and the direction of the lighting. You can select between surface types of Wireframe, Matt, Plastic, and Metal. You can create a contrast effect by selecting a different color for the extrusion portion of the object.


  Other Formatting


  When you have a Fontwork object selected, the formatting toolbar converts to the Drawing Object Properties toolbar. Here you can change the line color, line style, and color of the text. You can also change the anchor position of the object and how text will wrap around the object. You can also rotate the object, and since the background of the object is transparent, you can move the object up and down in a stack of objects to create other effects. You can also group it with other objects, images and shapes, to create some interesting graphic effects for your documents.


  In addition, you can bring up the full dialogs through Format > Object, or through the right-click menu. Here you can open the full area dialog which allows you to add shadows and other features not available in the toolbars. I have discussed some of these features in past articles. You can, for the most part, think of the Fontwork as just another object like an image or a shape.


  Fontwork is a quick and easy way to manipulate text in a creative way for your documents. Fontwork is available in all of the LibreOffice applications, making it easy to integrate with other objects. After you create a Fontwork object, you can edit it to form the object you want. Fontwork is just one more tool in the LibreOffice suite.


  Installing LinuxMint on a 2 disk RAID 0 set.


  Jan Mussche


  Installing an OS on RAID disks is something not publicised with every distribution. Ubuntu used to have the alternative setup with which it was possible to create a RAID system, but I think it was around 12.04 or 12.10 when they stopped releasing it. OpenSuse still has it in their extremely versatile installation program.


  In this article, which is a rewrite of a story Tartifola wrote on the Mint forums on Wed Jun 26, 2013 (http://forums.linuxmint.com/viewtopic.php?f=46&t=138044#p735417), all necessary steps are explained to install Mint on a RAID configuration to get a really fast system.


  First a little explanation of what RAID is and why it is used. RAID comes in several flavors, of which 0, 1 and 5 are the most commonly used. In this article, I will explain how to use RAID 0; the other RAID's are not so different, especially setting up RAID 1 looks a lot like what will be explained here.


  RAID stands for Redundant Array of Independent (or Inexpensive) Disks.


  
    	The Hardware:

      
        	Disks: because you need more than 1 physical disk to build a RAID. One disk with several partitions (which will then be called disks) won't do the job.


        	Independent: because, as I just wrote, the disks have to be real physical disks which can operate independently from each other. With more partitions on 1 disk, reading or writing on one partition can't be done when another action is active. The read/write head can't be in 2 places at the same time.


        	Array: the independent disks have to be placed together as a team to perform as one disk system, in what is called an array.

      

    


    	The Software:

      
        	Redundant is the software or data part. On a RAID system, to prevent data loss when something goes terribly wrong, you need to write extra or redundant data to the disks. This is to make sure that, should a disk go haywire, all your original data can be brought back, one way or another.

      

    

  


  RAID was invented in a time when disks were not so dependable, at least not the smaller ones. The bigger disks, which at that time cost a fortune, were better, but nobody could afford them. By placing together smaller disks, and adding extra data, a system was created to get disk systems with more capacity, which were faster than just 1 disk, and were still affordable for the majority of computer users.


  RAID 0 is, technically speaking, not a RAID since there is no redundant data. Still, it is part of the RAID family. With RAID 0, data is chopped into chunks (16kB, 32kB, 64kB, 128kB, 256kB, 512kB, etc) whatever has been chosen when setting up the RAID), and those chunks of data are sent to the disks, one chunk to disk 1, the next chunk to disk 2, then disk 1 again, and so on. The hard disk controller (in this case renamed RAID controller) does all this for you. This means that both disks are only reading/writing half of the total amount of data which reduces the read/write time. With RAID 0, since no redundant data is written onto both disk partitions, you get a new “disk” with a free writable area with a size equal to the sum of the disk partitions used to create the RAID.


  Because RAID 0 has no redundant data a warning is in order: Should a disk go haywire, you have lost everything, both your OS AND your data. With Just a Bunch Of Disks (JBOD), you will either still have your OS on one disk or your data on the other when one fails. With RAID 0, because all data is chopped into small pieces and those pieces are written intermittently to the 2 disks, you will only have parts of the files. You can see that you have only parts 1, 3, 5, 7 and 9 of a file when disk sdb fails. In other words, you end up with nothing.


  Using RAID 0 means making daily backups in order not to loose anything. Rsync, or even nicer, Grsync (with GUI) is a great program to do that.


  Before starting, it is a good idea to write down the partitioning scheme you plan to use. Think well about this, it is either the key to success or defeat.


  A Linux operating system needs a minimum of 2 partitions, one for “/” (the system disk), the other for “swap” (extended memory placed on disk should you run out of your normal memory). It is, however, a good idea to introduce a third partition, one which will be used for “/home”. It makes re-installing the OS, or even installing another one, so much easier. With a separate /home partition, you can keep all your data when re-installing, although it is always a good idea to make a good backup before you start.


  Now since the OS can't boot from a “/boot” folder within the RAID, we will make one more partition, a normal non-RAID one, for “/boot”.


  1. Preparing the disks


  All the operations to set up the disks, the RAID 0, and installing the OS, can be done from within the OS, so we will boot the computer with a live Mint disc (or USB stick). I use the KDE version for this since this is my favorite desktop environment.


  The first thing we need to do is to prepare the disks we want to use for Mint. This needs to be done now since the disks are not used at the moment; we use only the DVD or USB stick.


  In your live system you either have a partitioning program, or you can install gparted from the repositories. In my KDE system, I have KDE Partition Manager, so I am using that.


  I have used the following setup to install Mint in a virtual machine in which I created 2 disks each of 25GB. I made the following partitions on both disks:

  
Part.   Size        used for        Part.   Size        used for    Raid nr.
sda1:   128MB       /boot           sdb1:   128MB       not used
sda2:   8GB         /               sdb2:   8GB         /           /md2
sda3:   2GB         swap            sdb3:   2GB         swap        /md3
sda4:   Leftover    /home           sdb4:   Leftover    /home       /md4
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  In the above picture you see the partitioning scheme for the sda disk, the one for sdb is exactly the same. Before adding the partitions to both disks, it is good to choose menu “Device” first and from that menu, you choose New Partition Table. In the new smaller pop-up window, click on Create New Partition Table and finally click in the Toolbar on the Apply button. Do this for both disks. Now both disks are empty and you can start making your partitions on them.


  With the exception of sda1, which is going to be used for “/boot”, all partitions can be created without a file system. They will be used by the RAID setup, and a file system will be assigned to them later:


  
    	As said, sda1 will be used by “/boot”. Its counterpart, sdb1, will not be used at all. It is created just to keep both disks exactly the same.


    	sda2 and sdb2 will become md2 (multiple disk = RAID) and will be used for “/” with a total size of 16GB (sda2 + sdb2 = 8 + 8 = 16GB ). The number 2 is used because also the partitions have number 2. The MD number is however free to choose.


    	sda3 and sdb3 will become md3 and will be used as swap with a total size of 4GB


    	sda4 and sdb4 will be md4 and used for “/home”, making one partition of around 30GB.

  


  Right-click the line with the unallocated portion of the disk, choose New. A new window will pop up in which you choose the size of the new partition; you select Primary partition and (with the exception of sda1 which will have ext4), choose unformatted as file system. Do this for all the partitions you want to have. When done, click Apply to make the choice final. Do this for both disks.
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  2. Install mdadm


  In order to build a RAID, you need a program called mdadm (Multiple Disk Administrator). Use apt-get to install the most recent version. Open a terminal and type:


  
    
sudo apt-get install mdadm


  


  When you are not used to the terminal and typing instructions, you can also use your favorite software installer to do the work. Mind you, in the next part you will have to use the terminal.


  3. Creating the array (RAID 0)


  I created 3 arrays, one for /root, one for swap, and the last one for /home using:


  
    
sudo mdadm --create /dev/md2 --verbose --level=0 --raid-devices=2 /dev/sda2 /dev/sdb2
sudo mdadm --create /dev/md3 --verbose --level=0 --raid-devices=2 /dev/sda3 /dev/sdb3
sudo mdadm --create /dev/md4 --verbose --level=0 --raid-devices=2 /dev/sda4 /dev/sdb4


  


  (Mind the spaces in between the used options). Because we will not choose the chunk size ourselves the default value of 512kB will be used.


  To finish the partitions, I applied an ext4 file system to them.


  
    
sudo mkfs.ext4 /dev/md2
sudo mkfs.ext4 /dev/md4


  


  For Swap (md3) we have to use:


  
    
sudo mkswap /dev/md3


  


  You can check the status of your arrays with the instruction "cat /proc/mdstat":

  
md4 : active RAID 0 sdb4[1] sda4[0]
      31192064 blocks super 1.2 512k chunks
md3 : active RAID 0 sdb3[1] sda3[0]
      4193280 blocks super 1.2 512k chunks
md2 : active RAID 0 sdb2[1] sda2[0]
      16776192 blocks super 1.2 512k chunks
unused devices: <none>



  4. Launch the Installation


  At this stage you can launch the Mint installation and follow the steps until it asks for the installation type (ie, where you have to choose if you would like to erase your entire disk and install Mint or ...).


  You will see this:
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  Choose "Manual" or “Something else” (depending on your version of Mint, the last option in the list) and pay attention. The picture will now change into:
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  Clicking on Continue gives you this:
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  In the above picture, you see the 3 md's (2, 3 and 4) which have either the ext4 filesystem or swap. You also see the partitions which are used to build the RAID.


  If the previous steps are OK, you should be able to choose to mount md2, md3 and md4 to /root, swap and /home.


  Click on the line that says: /dev/md2 ext4


  Click on Change:
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  Choose the items as shown in the picture on the left. Click OK


  Do the same for md4 which will have a mount point of /home.


  Md3 will be used as swap. Here you need to choose swap area where it says: Use as: Other items for swap can be left as is since they are grayed out.


  Finally, mount /dev/sda1 to boot/ with file system ext4, and at the bottom of the Prepare Partitions picture, choose /dev/sda as the installation media for Grub.


  [image: OOPS]


  Continue with the installation till the end but do NOT REBOOT the machine. Choose: Continue Testing, and remain in the liveDVD.


  Remark: Here you see the KDE version of the Installation Complete window. In other versions, the 2 buttons might have switched places. So don't just assume you have to click the right one – read the text on the buttons.


  5. Install mdadm in the new environment


  Now comes the tricky part. Just now you say? Yes, so far it was easy going, but now things are getting serious. After the installation of the OS has completed, you still need to do one thing: install mdadm in the new setup. For this you need a terminal again… sorry… so open one.


  First you need to mount the array on which your system (/) has been installed (/dev/md2 in my case). The directory target is made during installation of the OS, we will now use it to mount (connect) several parts of our installed system to it. This way we can jump into the installed version very easily.


  Type:


  
    
sudo mount /dev/md2 /target/
sudo mount --bind /dev/ /target/dev/
sudo mount --bind /sys/ /target/sys/
sudo mount --bind /proc/ /target/proc/
sudo mount /dev/sda1 /target/boot/


  


  (again mind the spaces in the above lines).


  Before chrooting, remember to adjust the /etc/resolv.conf file in the new environment:


  
    
sudo cp /etc/resolv.conf /target/etc/resolv.conf


  


  Then you can chroot. Chroot means change root. It's a way to jump from one OS into another, in this case to the freshly installed one, which is mounted (connected) to the folder target in the live version we are still using: sudo chroot /target


  Install the proper software in the usual way and adjust grub to your likings:


  
    
sudo apt-get update
sudo apt-get install mdadm
sudo grub-install /dev/sda


  


  6. Reboot the system


  During reboot, you will be asked to remove the installation medium. Do this and press Enter. You will now boot into the installed OS on the RAID 0 system.


  
    Biography: I'm a 57 year young Linux enthusiast who started using Ubuntu in 2008 (Hardy Heron), and who is still learning about Linux every single day.
  


  The terminal tool ‘top’


  by Jürgen Weidner


  Many programs are available to help in identifying the reasons why a computer is running slowly. Top goes a step further and enables the user to intervene in running processes.


  What is a process


  A process is an instance of one or more connected tasks or threads which are executed by the computer. Some of them are independent, others are connected with each other. They use hardware like the processor (CPU), memory, screen, etc. The Linux kernel shares the available hardware with the running processes.


  With the help of control groups (cgroups), we can arrange single processes into groups, and allocate system resources to them based on the priority of the group. This is the work of the scheduler, which creates a queue that handles the processes based on their priorities.


  To identify, control and manipulate processes, the operating system assigns a PID (Process ID) to each of them. Usually the PID's are assigned in ascending order and remain unchanged as long the system is running.


  The program ‘top’


  To start top, we have to open a terminal and simply type in "top". Now the screens fills with a lot of data. To make some sense of it, let's take a look at the first row:
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  top - 20:14:42 up 57 min: gives the current time and how long the computer has been in use.


  1 user: number of users logged in.


  load average: 0.97, 1.11, 1.08: shows the load average (workload) of the CPU during the most recent 1.5 and 15 minutes. For better accuracy, divide it by the number of CPU cores so that for example 1.08 divided by 2 cores means that the work for each core is 0.54. If this number > 1, then a queue exists, and the scheduler must be invoked to allocate computing time.


  Tasks: 140 total, 1 running, 138 sleeping, 0 stopped, 1 Zombie: The second row displays the number of processes currently running, sleeping and stopped. The Zombie is a so-called child process, once started by a parent process, but not ended when the parent process was stopped. It's harmless, but if many are present, they may consume some memory and PID's.


  The third row shows the CPU workload for different clients:


  
    	"us" the user


    	"sy" the kernel


    	"ni" user jobs with low priority


    	"id" the idle Mode (if it’s high, then the workload is low, and vice versa)


    	"wa" the percentage of jobs waiting for computing time


    	Interrupts displayed in "hi" - hardware interrupts and "si" software interrupts


    	"st" (steal time) shows the amount of CPU power that a virtual machine is using.

  


  The fourth and the fifth rows show the usage of the memory and swap - the amount in use and the amount that’s still free.


  Below the system information we find the process list. It is structured in 12 parts:
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    PID     the process ID
    USER    the user who has started the task
    PR      process priority
    NI      the nice value
    VIRT    virtual memory
    RES     physical memory
    SHR     shared memory
    S       status
    %CPU    percentage of CPU power taken by the the process
    %MEM    percentage of memory used by the process
    TIME+   time since the process started
    COMMAND the command used to start the process



  There are some keyboard shortcuts to personalize the information displayed by top:


  

  t  hides/shows the second and third row in the info section (tasks, CPU usage, etc).

  m  hides or displays the fourth and the fifth row (memory, swap, etc).

  A  sorts the process list in order of resource usage.

  f  the user can decide what task details should be displayed by top.

  o  the user may configure the order of the list by his own needs.


  Working with top


  To manipulate a process, top offers two ways:


  
    	To stop a program that’s no longer needed, or that has crashed, the k (kill) command is very useful. After we give the k command, top asks for the PID of the program we want to stop. After typing in the PID, top asks us to confirm the input of the stop signal.


    	To manipulate the priority of a task, we use the command r (renice). With it, it's possible to reduce or to raise the priority of a process.

  


  The ‘r’ command may be unknown to many users, so these details may help:


  If a system is running slowly, top may help to analyze the reason. Mostly it will be sufficient to stop one or more processes to fix the problem. If this is not possible – because none of the running tasks can be terminated – their priority can be reduced and the priority of more important process can be raised. A higher priority means more computing time from the processor, and vice versa.


  Linux, based on UNIX, works with the UNIX system to determine priorities. The highest level is -20, the lowest 19. That means the more important a process is the lower is the assigned number. This number is called the ‘Nice Value’ and is displayed, as mentioned before, in the column NI in the process list.


  To raise a ‘nice value’, top must be started as root. To renice an owner (user) process, it is possible to do this without root power – but only to raise the priority, not to reduce it. For experimentation, it’s better to start ‘top’ in the user mode, and change the priority of only user tasks. Before changing any other tasks, please investigate what effects this will have on your system, especially for root tasks… avoid making experimental or unjustified changes.


  Conclusion


  Top is easy to understand, so everybody can use it. It has not only display functions, it also enables the user to intervene in processes.


  
    BIO: Jürgen is the former author of the now defunct YALM (Yet Another Linux Magazine) and a Linux user since 2007.
  


  Drawing with Inkscape – Part 44


  By Mark Crutch


  When I'm not drawing things in Inkscape, I like to spend my spare time playing lead guitar for a 1970s style prog rock band called “Envelope Deformation”. So when we decided to record our first album, it naturally fell on me to come up with a suitable logo for the band. My starting point, of course, was the name of the band in a bold font (Impact), with a golden gradient applied (when we hit the big time, no doubt our record company will pay for proper gold embossing on all our merchandising, so we may as well start as we mean to go on).
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  That's a good start, but it's a bit plain. I could use the Bend LPE from last time to add a bit of a curve to the whole logo, but 70’s style prog-rock really calls for something more indulgent. A quick scan through the list of LPEs reveals the suspiciously coincidentally named “Envelope Deformation” path effect, so that seems like an obvious one to try. After converting the text to a path (CTRL-K, then ungroup), then applying the LPE, I found myself faced with this user interface in the Path Effect Editor dialog.
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  Skipping the two checkboxes for now, what will be immediately apparent is that this looks like four sets of the UI from the Bend LPE. The four lines correspond to the four sides of the path's bounding box: by default they are straight horizontal and vertical paths, but by using the buttons in the same way as we did for the Bend LPE, you can deform each side along a bend path. The result is as though your skeleton path is printed on a rubber sheet whose sides are stretched, distorting the shape. For example, clicking the “Edit on-canvas” button for the Bottom bend path allows me to quickly change the logo to something more suitable for an album cover.
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  As you can see, the path currently being edited is displayed in green. Notice also that the deformation stretches across the whole height of the skeleton path, even though we only modified the bottom path. For more fine-grained control – such as keeping the top of the text horizontal – you have little choice but to engage in some manual node editing


  With just the Envelope Deformation LPE and a bit of tweaking to each of the four sides, we get closer to a classic prog-rock logo.
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  One thing I find frustrating is that three of the four bend paths are not displayed when you use on-canvas editing. For tweaking the shape of the path, that's not too much of a problem. But, if you decide to move the end nodes, it can be tricky to keep things in sync so that you don't lose the sharpness of the corners. Like the Bend LPE, however, our four lines in the UI also offer the ability to link to an existing path. It can be a bit fiddly to draw four lines that match the bounding box (Object > Objects to Guides can help), and then there's a lot of clicking to link them all up, but it does at least mean that you can keep an eye on all four paths at once – and even select nodes from more than one path at a time in order to move them in unison. Once your editing is done, simply set the opacity of the paths to 0 to make them disappear from sight.


  One thing to watch out for with this LPE is the direction of the paths. If your paths don't match the directions that the effect expects, you can easily end up with a result like this:
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  If that happens to you, just use Path > Reverse to change the order of your path's nodes without affecting their positions.


  As to those checkboxes… as their labels imply, they are used to enable or disable the top/bottom or left/right paths in the effect. Be aware that disabling a pair of paths is not the same as setting them to a straight line, which can lead to some confusing results. Where I find these options most useful is for creating trapezoid shapes. Here's the logo with left and right paths disabled, and the top path edited to be smaller than the bottom one:
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  The alternative, with left and right paths enabled, led to distortion around the bottom of the shape.


  Of course you can use the Envelope Deformation LPE with any path, not just one created from text. You can also stack it up with other LPEs, in case you want to stretch some Spiro Splines or add some fake perspective to a set of gears – although you sometimes get better results if you “fix” the earlier LPEs using Path > Object to Path, at the expense of the live editing capability.


  Like all good 70’s bands, however, halfway through writing this tutorial we had “artistic differences” and split up. The keyboard player and bassist got custody of the name; I got the singer and drummer. So we needed a new name for the band. The singer suggested “Live Path Effects”.


  “We would abbreviate it to LPE,” he said, “with the logo being something more geometric made up of the three letters crossing over and under each other.”


  “So something like the Emerson, Lake and Palmer logo?” I asked.


  “Erm… no, not at all like that. Their's is ELP, whereas ours is LPE. See the difference?”


  “I do, but I'm not sure their lawyers will.”


  Despite my misgivings, I began work on the logo. Starting with letters made from simple paths (red), I extended and arranged them to create something more logo-like (black).
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  For the “crossing over and under” requirement, it's another trip to the Path Effects dialog. First, as usual, I turned my separate paths into a single composite path using Path > Combine (CTRL-K). Then I added the Knot LPE, and watched in horror as much of my path seemed to vanish completely!
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  Unchecking a couple of the checkboxes got things back on track a little. Before explaining what each of them does, it will probably be more helpful to see the final result, with the parameters that produced it:
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  As you can see, this LPE automatically introduces gaps into a path where it crosses itself or any other sub-path. Most of the controls are used to simply alter the width of the gaps. With all the checkboxes cleared, the Fixed Width spinbox allows you to set a fixed size, in pixels, for the gaps. Check the “In units of stroke width” box, and it instead becomes a multiplier of the stroke width. The value of 1.50 that I've chosen just means that the gap will be 50% larger than the stroke, giving a nice 25% gap on either side.


  It is possible to apply this LPE to a group of paths, rather than a single composite path. In that case you could be dealing with different stroke widths as a thick line crosses over, or under, a thin one. The last two checkboxes let you add the width of the “under” stroke (the one that gets the gap inserted) and the “crossing path” stroke, respectively. This can be useful to automatically compensate for line differences in complex arrangements or to have gaps that automatically adjust if you change the stroke width, whether explicitly or just by scaling your design.


  Which brings us to the last control: Switcher size. In order to understand what this does, I first need to introduce you to the switcher. With your path selected, highlight the Knot LPE in the Path Effects dialog, then switch to Node Edit mode (F2, double-click on the path, or choose the second icon in the toolbox). You should now see the nodes of your path, as normal, but with one small addition. At one of the path crossings there will be a small, white, diamond-shaped handle. That's the switcher.


  It can be really hard to spot in Inkscape 0.48 and, despite the name of the control, changing the Switcher Size parameter will have no effect whatsoever. On 0.91, however, the switcher is surrounded by a blue arc or circle. Modifying the parameter will affect the size of the circle, making it easier to spot the switcher on a busy path with lots of intersections.


  But what does the switcher actually do? Clicking on it cycles the crossing between three states: the first two determine which path has the break (and therefore, which path appears to go over the other), whilst the third state removes the break entirely. Version 0.91 indicates these three states using a blue arc with an arrowhead pointing clockwise or anti-clockwise for the first two states, and a circle with no arrowhead to indicate the third state (0.48 offers no such indication). Unfortunately there's no fourth state to break both paths, leaving a large void. If you want that effect you'll have to manually break the paths yourself.
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  Whichever state you choose, however, only affects that one crossing point. You can drag the switcher to another crossing point in your design then change the state of that point by clicking. Being able to change only one point at a time like this, with a dragging process in-between, can quickly become tiresome on a complex design, but unfortunately there's no way to select or change multiple crossings at once.


  With the basics of the design complete, I added a couple of finishing touches to turn it into a proper logo. First I copied the original path and removed the LPE before using Path > Stroke to Path. This resulted in an outline version of the logo that I could then apply an extra stroke to in order to thicken it. I copied this version again, leaving me with three paths, one of which has the Knot LPE applied. By setting the fill and stroke to white on one of the copies, and setting a thicker black stroke on the third, I was then able to stack the paths on top of each other to produce the final effect.
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  There are a few things worth mentioning about the Knot LPE. Trying to edit the skeleton path while the LPE is visible can lead to Inkscape crashes, especially if you're still using version 0.48. Make sure you save regularly, and know where any auto-save files are stored. Simply turning off the visibility of the LPE in the Path Effects dialog is enough to mitigate this problem and you can then make it visible again afterwards.


  Depending on how your skeleton path was produced, you can also end up with unexpected breaks in it when using the Knot LPE. If this occurs, check for nodes that are doubled up on top of each other, perhaps as the result of a boolean operation. These can be fixed using the Node tool by rubber-band selecting the two nodes in question, then using the “Join Selected Nodes” button on the tool control bar to combine them into one. Where misplaced breaks are not due to doubled up nodes, your only recourse is to reshape your path a little. Try adding a node at a nearby intersection, then removing the one at the break, or adding another node close to the breaking one.


  It's also worth reiterating that a Live Path Effect takes a path as its input, and produces a path as its output. Therefore your knotted path is still just a path, so is limited by the choice of end-caps that are available in SVG. If your paths cross at 90°, as in the logo example, butt or square caps will usually produce a good result. For anything else, however, you might find that rounded caps are better. This restriction does limit the artistic effects you can get from this LPE when lines have to cross at shallow angles. In the following example, the red and blue lines are broken using the Knot LPE with round and square caps. To get the effect of the purple line, however, it was necessary to convert the stroke to a path, then manually cut out the gaps.
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  All the practice of designing our new logo looked like it would be particularly useful when the lead singer declared that our album would be called “Celtic Knot”. I quickly designed a potential album cover.
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  Thanks to the Knot LPE it didn't take too long to produce that design – which is a good thing, as the following day the singer decided that he was leaving the band to go on a spiritual retreat to India. Perhaps I should form an 80’s style synth pop group instead. “Spiro Spline” sounds like a great band name to me…


  
    Mark uses Inkscape to create three webcomics, 'The Greys', 'Monsters, Inked' and 'Elvie', which can all be found at http://www.peppertop.com/
  


  Arduino


  by Ronnie Tucker


  This month’s Arduino article is connected to my Linux Labs article (earlier in this issue) on building the RepRapPro Fisher 1 3D printer. How? Well, the Fisher 1 is powered by a board which is entirely compatible with the Arduino Due.
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  The Duet


  The Duet was developed by Andy and Tony from Think3dPrint3d in conjunction with RepRapPro. It’s entirely compatible with the Arduino Due and is purposely built for 3D printers. It mashes together the Due with five stepper motor controllers (the five sets of seven pins at the top of the board in the photo). It also has an Ethernet port and a high speed SD card slot.


  Open


  According to the wiki page: The Duet hardware design is licensed under the CERN OHW License 1.2 (http://www.ohwr.org/documents/294): the design is free to be distributed and modified within the terms of this license. All the design files are available on Github (https://github.com/T3P3/Duet). The Duet was completely designed using the Open Source software package KiCAD (http://www.kicad-pcb.org/display/KICAD/KiCad+EDA+Software+Suite) so hacking and building on this design is accessible to all.


  Software


  Running RepRap Firmware, the software receives GCode (the commands that tell the printer where to place the print head) via the USB port, and from the SD card or from the Ethernet interface. The Arduino IDE (amongst other things) allows the firmware to be updated, or replaced by other firmware which is not from RepRapPro.


  Personally, I’ve not used the USB port for uploading files to the printer, but I have used the Ethernet interface and the SD card. Both work like a charm.


  Conclusion


  Follow along with my future Linux Labs articles and you’ll see how important this little board is when it comes to 3D printing.


  Source: http://reprap.org/wiki/Duet


  Chrome Cult 9


  bySJ Webb


  A Chromebook does a wonderful job of being secure. It does not allow foreign software installs, thus preventing malware. It has secured boot to prevent BIOS tampering. If you use the guest mode on a Chromebook, it erases all evidence. The SSD is automatically encrypted.


  However your storage peripherals are not encrypted.


  There are some Chrome Extensions that can help: Virtru and Minilock. Virtru ensures encrypted email from a Gmail account. Minilock does file encryption, but it does not encrypt USB thumb drives or SD cards. In fact all of the encryption tools can do only files. In time, another encryption app called Signal will become available. Signal promises encrypted messages, emails, and phone calls that sync from your desktop to phone.


  Let’s take a look at Minilock. It’s supposed to be an easy-to-use extension. However, I could not get an encrypted file out of the app. Once a file is selected, it only reads it – with no further progression.
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  There are two better choices for online file encryption that do encrypt files, and are self-explanatory: encrypt.ion and Encrypt, Decrypt files with Drive. These apps are in the Chrome Web Store. It is a simple drag-and-drop to encrypt a file. It is just as easy to decrypt.
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  While these apps do safeguard my files, do the files reside in their cloud? Would it be possible for someone to have access to my encryption key? Both of these apps reside in the browser and are not standalone products on the desktop. I would be hesitant to encrypt all of my files with these apps. If I was traveling, I would use the encrypt.ion for important documents related to my work. I’d rather trust an encryption tool from a true desktop like Ubuntu or Manjaro.


  Virtru. I would like to credit viking from the Manjaro forums for informing me about this app. Virtru works with Gmail, Yahoo, and Outlook email accounts. It works for Firefox and Chrome browsers. It is very simple to install. It is possible to send an encrypted email one way without the other person needing to have Virtru installed. I confirmed this by sending a test email to my secondary email account.
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  Overall, there are many tools out there to encrypt your data. If you use a VPN and some encryption tools, you should have strong protection on your privacy. Remember that Chrome OS is corporate Linux, and you should use some safeguards.
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  Write For Full Circle Magazine


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives—Kubuntu, Xubuntu, Lubuntu, etc.

  

  Write your article in whichever software you choose—I would recommend LibreOffice. But, please spell and grammar-check it!

  

  The Official Full Circle Style Guide can be read at: http://url.fullcirclemagazine.org/75d471

  

  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.

  

  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!

  



  FOR REVIEWS:


  Games/Applications

  When reviewing games/applications, please state clearly:

  • title of the game

  • who makes the game

  • is it free, or a paid download?

  • where to get it from (give download/homepage URL)

  • is it Linux native, or did you use Wine?

  • your marks out of five

  • a summary – with positive and negative points

  

  Hardware

  When reviewing hardware, please state clearly:

  • make and model of the hardware

  • what category would you put this hardware into?

  • any glitches that you had while using the hardware?

  • easy to get the hardware working in Linux?

  • did you have to use Windows drivers?

  • marks out of five

  • a summary – with positive and negative points

  

  You don't need to be an expert to write an article – write about the games, applications and hardware that you use every day.


  Linux Labs

  RepRapPro Fisher 1 Build - Part 1


  by Ronnie Tucker


  I had always fancied buying a 3D printer, and did some preliminary research. Unfortunately, most of them didn’t support Linux, so I wasn’t spending a couple of hundred pounds on one. One day, while scrolling through my Google+ feed, I saw that fellow Linux user Alan Lord had been building a 3D printer with his son. I enquired about the printer, and its compatibility, and with it being around the £200 mark... it was perfect!


  The RepRapPro Fisher 1 uses an Arduino compatible board as a controller, which has a micro-SD port. You can either store files to print on the SD card, or you can upload to the SD card from the Fisher’s interface. You connect the printer to your router or, in my case, connect it directly to a desktop/laptop PC. More on direct connections near the end of this series when I show how I connected mine directly to my laptop.


  What’s In The Box?
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  Opening that box, and seeing all those bits, is quite intimidating. Thankfully RepRapPro has some excellent build instructions: https://reprappro.com/documentation/fisher-1. Those of you who bought an earlier Fisher, which was still in beta, will notice that some parts, and the build, are different.


  I should also mention that the Fisher 1 comes in two flavors. The first, the more expensive, is a full kit with everything you need. This is the one I bought. The second, slightly cheaper, is a kit with some parts not included. The idea behind this is that if you already have a 3D printer you can print some parts yourself.


  The Base


  The first thing that needs to be built is the base. This is a triangular shaped plastic base which has three pairs of rods connected to a motor. This is the first hurdle as you must make sure that of the three motors, two must have their connection pointing to the left, and the third should be pointing right. Thankfully, RepRap does highlight this in the instructions.


  Next, the actual base. Everything that’s black plastic has a thin film over both sides. It may not look like it, but it does. You must peel it off.


  The Duet (the Arduino style board) is screwed to the base and the three pairs of rods are fed through holes in the base and screwed into place.
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  The Tower


  Three carriages are used to move three arms up and down (and effectively, in and out). These are created using two metal cylinders, one of the (in my case) supplied printed parts, and several screws and bolts.


  All the screws, bolts and washers are in ziplock bags with part numbers on them. Each stage of the build instructions will tell you exactly which screw or washer to use. For example: Using an M3x16mm cap head screw, fit this into the carriage as shown. Put an M3 plain washer, then an M3 Nylock nut, to hold it in place.


  Looking at the components list at the start of the section it says:


  
    
      	#

      	Component

      	Qty

      	Type
    


    
      	242

      	M3x16mm cap head screw

      	2

      	Fastener
    


    
      	204

      	M3 Nylock nut

      	2

      	Fastener
    


    
      	212

      	M3 plain washer

      	2

      	Fastener
    


    
      	258

      	M3 nut

      	1

      	Fastener
    

  


  That tells you exactly which bag to go for (Fastener), part number (which is on the bag), the name of the component, and how many you’ll need.


  The carriages are tricky and you really need to take time to get these spot on. Ideally you’ll need digital callipers for this as you need to screw a couple of threaded steel balls on either end and the width from ball to ball is specified and needs to be exact. If needed, you may have to file down the screws to bring the balls inwards to meet the target.


  With three carriages made, you slide them down the pairs of rods.


  At the top of each pair of rods is an idler bracket. Nearer the end you’ll wrap the toothed belt through carriages and over these idler brackets.
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  Next month, it’ll be side panels, more rods, and (the rather tricky) effector assembly.


  Ubuntu Phones


  OTA-8.5


  This list is only a highlight of the few changes available in this update. Please check the detailed changes for all the changes included in this OTA.


  Important features


  Even though this is a bugfix only release and no new features were planned, we had to include one which was essential to the release of one bugfix:


  
    	Background playlists in media-hub

  


  Bugfixes


  As we know, each release includes a huge number of bugs - some for previous issues and some for new regressions introduced in-between. To see the overall list of what issues got fixed, please check the detailed changes below. The interesting ones are as follows:


  
    	Fix for HTML5 webapp apparmor denials


    	Music app high power consumption fix


    	Fix for UI freezes due to dbus signals


    	Fixing SIM card contact imports


    	Fix apps installation for the time-skew issues

  


  Detailed changes


  Milestone bug list: https://launchpad.net/canonical-devices-system-image/+milestone/ww50-2015

  


  Ubuntu At The China Mobile Worldwide Partner Conference


  Although no new devices were announced Ubuntu Touch was shown running on a Nexus device in desktop mode.
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  Strangely, the Meizu MX4 Ubuntu Edition was shown even though it has been sold out now for quite a while. Maybe it’ll make a return?


  One new phone did surface (see photo), but it is rumoured to be either a prototype, or a development, device.
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  Book Review: Spam Nation


  Written by Jonathan Hoskin
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  SPAM NATION

  by Brian Krebs

  Sourcebooks Inc.

  306 Pages

  Paperback

  ISBN: 978-1492603238


  The epidemic we call spam is the topic of Spam Nation by Brian Krebs. It is a bit unusual in the computer technical genre to focus so sharply on one issue, and specifically one that might be considered to be the scourge of our existence. We understandably want to keep our virtual fingertips away from the less palatable portion of the Internet lest we get them dirty. But knowledge of the people, personalities and ploys can make us more capable of predicting or recognizing the next criminal paradigm – or at least we hope.


  Spam Nation is most obviously a history of spam and the organized crime accompanying it, but equally important is the perseverance and courage exhibited by its writer. When the newspaper he worked for didn't have the backbone to weather a possible, albeit questionable, legal retaliation for his writings on the subject, Krebs started his own now famous blog: Krebs on Security (KrebsOnSecurity.com). Along the way he was swatted enough times to make it seem routine. (Swat teams were surreptitiously directed to his home to intentionally endanger his family and neighbors by the very cyber-criminals he wrote about.) Illegal drugs were also delivered to his door and the authorities notified, all unbeknownst to him. Eventually he even made what might have seemed a foolish decision to go directly to the source and he traveled to Moscow, the center of the trade that had become the gateway to online pharmacies. But after all, he is an investigative reporter and that is what they do. Two major trade spam partnerships, GlavMed and Rx-Promotion, would become the major players, becoming so significant they could advertise their services.


  Although not the original type, it's the email version of SPAM that we all love to hate. It may seem like the deluge of spam has ended but that is more likely just a temporary lull. While spammers email is not yet flawless, it's getting more and more difficult for automated systems to recognize the bogus variety and distressingly difficult for mere flesh and blood readers. That is because, for cyber-badguys in the spam trade, like all cyber-crime, the only way to remain relevant is to get better faster than the good guys. They remain on the cutting edge, and thus everyone must remain vigilant. In phase two, their current status is like many start-up internet companies; they have a good idea but monetizing is the problem. The bottleneck in the Spam enterprise had become the payment system which, unfortunately for them, has recently been subject to much greater scrutiny, and they have not fared well. But you can be sure that, if there is a way to move money around, they will get their hands on it. And another good bet is that you will read about it in a future story in the Krebs on Security blog.


  The spamming industry may have started with disorganized individual efforts but eventually crystallized into an organized industry which necessarily had to address the quality issue. This had less to do with honor among thieves and more to do with business practices that allow growth and continuing profits. By now it seems that every email account on the planet has received hundreds of Viagra ads, mostly filtered out. For drugs that might have been of an embarrassing nature such as erectile dysfunction, it would make a limited business. But it blossomed such that online pharmaceuticals would cover all needs, although it would be curtailed in countries wanting to protect their citizens/industries via more vigilant policing. To remain viable the focus had to be on price, confidentiality, convenience and dependency. That required an organization.


  One example is “Steve,” having gotten gonorrhea from the woman, by then ex-girlfriend, who kindly let him know the drug she was prescribed. With no co-pay, and clearly less expensive on the Internet, the purchase was a no-brainer for Steve because he had also recently been let go from his job. His experience may have been typical; sales operations persist because of satisfied repeat customers. Purchasers of low volume, very expensive drugs may not always have had a positive experience. But there was never a guarantee, the delivered items may have been the legitimate drug, a pill with no active ingredients, or even a toxic substance, all of which might be sold in what looked like the real blister-pack. Legal authorities were always quick to point out the bad and lethal cases even though the phrase “buyer beware” is relevant for any purchase. Given most drugs are made in China and India, legitimate or counterfeit, it's hard to tell what is a real item. The above mentioned organizations would thus look upon such activities harshly if it reflected poorly on their operations, and take appropriate actions.


  This book has elements of a crime thriller, a how-to guide and a dissatisfied customer who tells all. You immediately know there is a Russian connection because he starts with a list of 15 significant players in the Spam cyber-world along with short descriptions of their activities. It doesn’t take much convincing to decide they are not individuals you want to meet, assuming they are alive and not in free, very secure government housing. Most of them didn't get the money and high end lifestyle by being nice guys, but you could have guessed that part. There are payoffs to government officials, double-crosses and organized crime style retaliations. While business enterprises (that bring money into the country but don't harm its citizens) are sometimes tolerated, eventually the country in question can’t deny any knowledge and must turn up the heat on the miscreants.


  Setting aside the business part, it's the technical wizardry that necessarily defines the mostly unseen programmers that keep the web sites running. Their redundancy and secure record-keeping gets put to the test. They have to be not just world class but able to circumvent the best efforts of countries trying to shut them down, and sometimes their competition. (Governments and corporations could learn a thing or two from these guys.) But, like many a murder mystery, their Achilles heel was and remains the money. Credit card processing networks like ChronoPay, with laundering schemes and various flavors of virtual money like BitCoin, were avenues taken, but too often for the bad guys, they would eventually become undependable.


  Spam Nation is a book about the rise and fall of one part of organized crime. There were real companies and brands like Pfizer and Vista affected. It took the concerted effort of many government offices/countries to bring it down. There is a lot to learn in this book for both sides, but it can't be over. History has shown that, legal or not, whenever there is a demand for products and services, a more sophisticated, stealthy venture can emerge and circumvent the current business controls. Spam Nation is a book about that process.


  Book Review: Doing Math with Python


  by Elmer Perry
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  August 201 5, 264 pp.

  ISBN: 978-1 -59327-640-9


  Are your students future scientists or mathematicians? Do they seem to enjoy exploring the world or playing with numbers? Or perhaps they just like creating things on the computer? Doing Math with Python is a possible choice for a student or a teacher to use to teach and enhance a student's skills. For some students, it could help them get a better understand of some of the mathematical topics discussed. For young, budding scientists, the book can help them learn how to collect and analyze data. The programmer will learn to break complicated problems into smaller ones in order to find a solution.


  The book was written by Amit Saha, a software engineer. He also created and maintains Fedora Scientific, a Linux distribution for scientific and educational users.


  The language of the book is simple and easy to follow. The book does assume you are familiar with the basics of Python. The author does a good job of teaching how to break complicated formulas down into pieces in order to avoid long complicated statements in Python. In many cases, I felt like I understood the formula better after this process. The division of large formulas into smaller expressions could help a struggling math or science student to succeed. The explanations of the mathematics and the programming are clear and easy to follow. This book is as much a math and science book as it is a programming book. Amit has brought the three topics together in a very natural and pleasing way. Using the computer makes it quicker and easier to change and play with the results. I must admit, I had a few eureka moments myself, and times when I had to force myself to move on because I was spending a lot of time playing with the numbers to get new results.


  The book is divided into 7 chapters. The following is a short synopsis of each chapter.


  Chapter 1, Working with Numbers, is an introduction to the book. You review the different types of numbers you can create in Python, including fractions and complex numbers. You also see how to use the basic mathematical operators (plus, minus, multiplication, division, modulo, and exponents) built into Python. You learn to assign a label to a number for use later in a program. He calls them labels rather than the traditional variable to avoid confusion when the term is used in the mathematical sense. You see how to create and work with fractions and complex numbers as well as do mathematical operations with these number types. Getting and verifying user's input is given a once-over and discussed often in the course of the book. Your first program is a program that calculates the factors of a supplied number. The first big step in the book is translating the root of a quadratic equation using the functions and operators built into Python.


  Chapter 2, Visualizing Data Using Graphs, teaches you the basics of plotting a graph using the matplotlib module. You learn to feed data into the plot function, give the graph a title and labels, create a legend, and control the minimum and maximum values of the X and Y axes. After plotting several single-line charts, you plot a series of multiple-line plots, showing you how to use a graph to do a comparison of two sets of data. Finally, you use a formula to generate the data you plot on your graph. This is an important step in the evolution of your skills with the matplotlib module. In the challenges at the end of the chapter, you even learn how to create a bar chart using the matplotlib.


  Chapter 3, Describing Data with Statistics, you dive into the exciting world of statistics. You create functions for calculating the basic equations of statistics, mean, median, mode, range, variance, and standard deviation. Although not directly discussed in the book, these functions would make a good library collected into one file. You work through the complicated formula for calculating a Correlation Coefficient between two sets of numbers. You then learn how to create a scatter plot in matplotlib. If you have never used a scatter plot before, you learn that even though the mean, standard deviation, and correlation of sets may look the same, scatter plots can give a view of the data that tells a whole new story. With a scatter plot, you can see the outliers that can skew your numbers. You then get a refresher on how to import data from a text file, and more importantly, how to import data from a comma-separated value (CSV) file. CSV files are a good way to get large amounts of data into your program.


  Chapter 4, Algebra and Symbolic Math with SymPy, plunges you into the world of Algebra and symbolic math. SymPy is a module that allows you to use symbols in your formula and get results. After learning how to create a symbol object, you begin to work with Algebraic expressions, factoring expressions, creating series, simplifying expressions, and substituting values for symbols. Then you are off solving equations and plotting equations using SymPy. This naturally led to plotting multiple expressions on one chart.


  Chapter 5, Playing with Sets and Probability, introduces you to creating sets in SymPy. SymPy sets behave just like mathematical sets and give you the ability to calculate subsets, supersets, and power sets. It also has the set operators for union, intersection, and Cartesian product. With these tools in hand, you find yourself applying sets to formulas and getting results. You are also introduced to working with probability using sets. This uses the union and intersection of sets to create an event set for calculating the probability of the resulting set. The work with probability includes both uniform and nonuniform probabilities.


  Chapter 6, Drawing Geometric Shapes and Fractals, will be your favorite chapter if you enjoy geometry. You discover how to draw circles, animate them on a graph, and even create an animated trajectory chart. Next, you learn about fractals and how they are made. You start with a simple zigzag with four formulas with equal probability, then move on to a Bransley Fern that uses the skills of nonuniform probability introduced in the previous chapter. Overall a good time of learning and creating interesting charts.


  Chapter 7, Solving Calculus Problems, brings everything together to discuss the most advanced math in the book. Amit begins by defining what a function is. After a quick overview of common mathematical functions, you dive into finding the limit of functions. This includes some new methods in SymPy. You use Python to calculate compound interest and rate of change. Then you plunge into derivatives, including partial derivatives and high-order derivatives. You find and plot the global maximum using gradient ascent. Next, you learn how to use SymPy to find the integrals of functions. Finally, you learn about the probability density functions.


  Whether your student is a budding mathematician, scientist, programmer, or maybe even struggling with one of the subjects, ‘Doing Math with Python’ is a great book for exploring the topics of computer programming, mathematics, or science. Each topic builds on the previous to build a solid knowledge of each topic. After ‘Teach Your Kids to Code’ by Bryson Payne (see review in Full Circle issue 98), Doing Math with Python would make a good follow-up book for a secondary school level code club. If you teach mathematics or science, you might want to consider it as a supplemental text, or the topics could be expanded to create a class on its own.


  Q&A


  By Gord Campbell


  
    	Q How can I identify the graphics card in my computer?


    	A (Thanks to Vladlenin5000 in the Ubuntu Forums) System Settings > Details


    	

    



    	Q I have just allowed the installation of the VirtualBox update to version 4.3.34 (was on 4.3.10). All my Virtual machines now crash when loading, except for one Windows XP VM. The crash occurs at the point where the Windows Logo appears on boot-up. I tried using F12 and booting from the Windows 7 Installation CD but that crashed in the same way. I am on Ubuntu 14.04.


    	A (Thanks to ajgreeny and philchambers in the Ubuntu Forums) I have downloaded and installed the latest VB from the VB site (5.0.10) and that has fixed things.


    	

    



    	Q How to block emails in Thunderbird mail? I am unsubscribing to as many mass junk emails as I can. However, sometimes the email doesn't have an unsubscribe option.


    	A (Thanks to Jim_deadlock in the Ubuntu Forums) Thunderbird has an adaptive spam filter, it "learns" as it goes. The more messages you mark as spam the more efficient it will become. Also, never "unsubscribe" from spam, it will just make it worse, just mark it as spam.


    	

    



    	Q I'm selling an Acer Revo Aspire. It has only Ubuntu as an operating system, but I want to delete all my personal info before selling.


    	A Download DBAN, burn it to a CD, boot from it, run with the defaults, which will probably take a couple of hours. If you want your buyer to have an operating system, do an "OEM" install of Ubuntu: https://help.ubuntu.com/community/Ubuntu_OEM_Installer_Overview


    	

    



    	Q I connected ipad to g5, and I opened ipad in Nautilus, and everything is ok. I have videos of about 3 GB space and I copied that stuff to the DCIM/100APPLE folder on ipad, but no video playing app recognizes anything, just like I didn't copy anything.


    	A (Thanks to TheFu in the Ubuntu Forums) Transcode the video files to a format supported by your ipad. Generally, that will be h.264/aac/mp4 files. There are specific settings required for Apple stuff to work. Handbrake is a tool which should be able to do it, and has presets just for Apple, but there will be a loss of quality, as all transcoding loses qualify.


    	

    



    	Q I recently upgraded my motherboard and processor. Windows was a real pain to me so I decided to go with Ubuntu. However, I ran into more than a few problems with my installation... I tried to run a memtest, but it got stuck at 6% on the first pass.


    	A Yup, it was the RAM.


    	

    


  

  


  Top questions at Askubuntu


  
    	Can I convert hex to decimal using the calculator app?

    http://goo.gl/i0i17n

    



    	found ls binary using whereis, but can't find ll. Why?

    http://goo.gl/wNnX6Z

    



    	Interactive Periodic Table

    http://goo.gl/b728Oe

    



    	How to boot from a USB drive in VirtualBox?

    http://goo.gl/gbLXU8

    



    	A timer that automatically locks the screen to take a break away from the computer?

    http://goo.gl/VduRpd

    



    	Security risk in everyday use of an admin account (not root)?

    http://goo.gl/5iCKvm

    



    	How to combine the output of multiple find commands?

    http://goo.gl/nNnY10

    



    	Format usb and confirm all zeros

    http://goo.gl/163fXm

    



    	Leaving old kernels installed could be dangerous?

    http://goo.gl/cVuI9z

    


  


  


  


  Tips and Techniques


  Well, Darn


  I didn't do anything interesting in Linux this month. Professionally, I'm looking at Windows 10 with a view to a corporate rollout in the spring. It's an accounting shop. The typical computer has almost 200 "applications" installed, and none of them run under Linux. (A potential client walks in and says, "I haven't filed a tax return for 12 years, and I have income in both Canada and the United States." That's two dozen "applications" right there.)


  At a personal level, my wife and I are seeking legal custody of her grandson, which requires quite a lot of work. He's a very bright eight-year-old who came from China a year and a half ago. We're looking after him, but need legal standing to make educational and medical decisions on his behalf. Our house got a lot noisier when he arrived!


  [image: OOPS]


  My picture celebrates “Movember”. Look it up.


  One thing I have noticed in Linux: Xubuntu 15.10 mounts my Android phone as an external drive, which makes transferring files back and forth much easier.


  Using VeraCrypt to hide your files.


  Scott Kenney


  For many years, TrueCrypt was my encryption program of choice to encrypt my files on my computer. I liked how it worked on both my Linux and Windows systems. However, in May of 2014, TrueCrypt was discontinued, and the last version to be released (7.2) only removed encryption for files and containers.


  Since then the project was forked to the VeraCrypt program, and this is the program that I'm running today.


  I use VeraCrypt to create “containers”, which can be mounted to the file system and files written to it. Then the container can be encrypted, and sit among your other files in plain sight. Only you will know that the file is a container. This makes it easier to keep a small amount of files encrypted, if you have no need for whole disk encryption.


  To get VeraCrypt installed on your computer, head over to https://veracrypt.codeplex.com/ and download the source code. In this tutorial, we'll be downloading the latest version, 1.13.


  Once you have the file downloaded, extract it by either using right-click and “Extract Here”, or from the command-line by typing: tar xvf veracrypt-1.13-setup.tar.bz2


  At this point you'll have four files extracted. Two are for a console installation (32 and 64-bit), and two are for GUI installation (32 and 64-bit). In this case, we'll use the 32-bit GUI install. You can issue the command:


  
    
sh veracrypt-1.13-setup-gui-x86


  


  Because we've already extracted the package, go ahead and select 'Install VeraCrypt”.
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  Next step is to read through the license terms. You can use the scroll bars on the left side to read them, and once you are done, you can accept it at the bottom.


  [image: OOPS]


  After this, we'll see a message about uninstall instructions. If you ever want to uninstall VeraCrypt, you'll use this command: veracrypt-uninstall.sh


  Type in your root password at the prompt, and press return. The package will install several files, and once it's done, will direct you to press “enter” to exit the terminal. To start the program, click on the home button and search for “Vera”. The VeraCrypt program will be displayed. Click it to get started!


  [image: OOPS]


  Once the program starts, you'll be presented with several empty slots. Our first task is to create an empty container. The easiest thing to do is to create one container, put a password on it, and then mount your container. This is the process that we'll walk through. After that, we'll work on setting up a two-step system for better security. So to get started, click on the “create volume” button.


  [image: OOPS]


  For our tutorial, we'll create an encrypted file container, so select the first option. Select “Standard VeraCrypt Volume” on the next screen.


  [image: OOPS]


  At this point, VeraCrypt wants you to select a file to make a container. You don't want to use an existing file, because it will be deleted and replaced with the newly-created VeraCrypt file. So what you can do is create an empty text file, and call it whatever you want. For security purposes, don't call the file something obvious like “secret container”, but rather use an innocent-sounding name. In this case, I created a text file named, “Ubuntu-14.04-install-inst.txt”. Since I'm running 15.04, I know that I will not need instructions to install 14.04, but others will just see that file and assume it's an older file. Once you've selected the file, press Next. VeraCrypt will warn you that the file will be replaced, but since we created the file expressly for VeraCrypt, we're ok.


  Now you get to select which kind of encryption you want. The differences in the types of encryption are beyond the scope of this tutorial, so for our purposes we'll just select AES(Twofish) and select Next.
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  Now you determine how big you want to make your container. We'll select a simple 500MB container. After clicking next, you'll choose the password you want for the container.


  [image: OOPS]


  Now you'll be presented with the format options of the container. If you plan on using the container only in Linux, you can choose the Ext4 file system. However if you want the container to be mounted in Windows also, select “FAT”.
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  It’s time to encrypt the container! By moving the mouse around, you'll increase the cryptographic strength of the encryption keys. When you are satisfied with the strength (or just impatient), click Format to create the container. You'll get one more warning that the file already exists. Since we created the file for this purpose, we can format it.


  Once it's finished, you'll be presented with a dialog saying it was successful. Now it's time to mount the container and use it! Go back to the original screen with the 12 different slots, and this time click on “select file”. Navigate to where you created your container, and select it. Once you have the correct file, click on a slot where you want to mount the container, and select “mount” at the bottom. You'll enter the password you created for the container at this point. VeraCrypt will then ask for your root password in order to mount it.


  [image: OOPS]


  Here we can see that our 500MB container is mounted in slot 5 of VeraCrypt. Opening our file manager of choice we can see that it is indeed mounted and ready for files. In this case, Dolphin is reporting a new 499.8 MB hard drive.


  [image: OOPS]


  When you are done with the container, you need to dismount the drive, so it can close properly. Simply click “Dismount” and VeraCrypt will dismount the drive. To verify that you closed it correctly, go back to your file manager and see if it's there.


  [image: OOPS]


  Indeed, it's dismounted, and no longer displays on the list of devices!


  So that's the basics of creating an encrypted file container. You can move the container anywhere you want, it doesn't have to stay in the directory where it was created. For better security, you might want to try creating a two-tier system. What you can do is create a simple 1MB file with a simple password. Mount that container, and inside it create a text file. Open the text file, and insert a very complicated password and that's it. No reference to anything else. Save it, and dismount the container. Now create a container as big as you want, and use the complicated password (that you are storing on the text file in the 1 MB container) as the password to open it. In naming the bigger container, think how big you want it, and give it a filename that can blend in with similar files. For example:


  
    
      	File Size

      	Suggestion decoy names
    


    
      	1-2 MB

      	Documents and pictures
    


    
      	4-5 MB

      	MP3 or other sound files
    


    
      	50-100 MB

      	AVI or MP4 video files (Music videos)
    


    
      	700MB-1.3 GB

      	MP4, mk4, AVI video files (full length movies)
    


    
      	3-4 GB

      	ISO files (linux distros)
    

  


  Store that container among the other files in that directory, and just remember it's a container, and not actually what the label says. If the small container gets compromised, all it will have is the complicated password, but not what it goes to. If you named your larger container in such a way that it blends in with other files, others will have a tough time looking for it.


  That wraps up our VeraCrypt tutorial, and should get you started in encrypting and hiding your sensitive files. Remember that longer passwords are better, and don't accidentally delete your containers thinking they are something else!


  
    Bio – Scott Kenney lives in Oklahoma, USA with his wife and four kids. He has been using Linux in one form or another since 2010. His current preferred distro is Kubuntu 14.04.
  


  Linux Loopback


  bySJ Webb


  A joint research project between the Massachusetts Institute of Technology, Bell Labs and General Electric ended in the 1960s. This project was called Multics. The last researchers on the project were Ken Thompson, Dennis Ritchie, M.D. McEllroy and J.F. Ossanna. These researchers would continue working the Multics main end game: continuing the work that became the base to UNIX. This new OS started in 1970. The entire OS was rewritten in the C program language.


  [image: OOPS] [image: OOPS]


  The first computer running UNIX was the PDP-7. UNIX was used as a word processor for the Bell Labs patent office in 1971. The success of UNIX in this fashion allowed a PDP-11 to be purchased and further improvements to the base code. UNIX came to the public in 1974 based off a published paper. The first license was sold to the University of Illinois in 1975.


  [image: OOPS]
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  From 1975 to 1980 Unix grew in academic circles. There were various UNIX variants, perhaps the most famous is BSD out of the University of California Berkeley. From 1980 to 1985 UNIX was commercialized and adopted by the commercial world.


  In the late 1980’s, Sun Microsystems and AT&T Labs partnered to improve on UNIX. In 1992 ATT dissolved this partnership and sold the UNIX trademark to Novell. UNIX has shuffled owners a few times over the years.


  Steam Link and Controller


  by Ronnie Tucker


  I decided to take a gamble and buy a Steam Link and controller just after the initial first batch. It was a gamble as a lot of the games in my Steam library are mouse and/or keyboard games. I knew that some just wouldn’t be suitable (X-Plane 10), but I hoped that some others (Euro Truck Simulator 2, Perfect Golf, etc) would be usable since the controller did seem to have pretty good key-mapping capabilities.


  Steam Link


  The Link is a small device, about the size of a pack of playing cards, which connects to your gaming device using either Wi-Fi or ethernet, and connects to your TV using an HDMI cable.


  You turn it on, turn your TV to the appropriate channel and, after initial setup, you’re greeted by the Steam Link screen to connect to your gaming PC.


  [image: OOPS]


  After selecting your PC the Steam software (on your PC) will go into Big Picture (aka: full screen) mode.


  [image: OOPS]


  It’s a nice interface. From here you can browse your library, the Steam store, chat, and so on.
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  Once in your library, you can browse through your games for something to relax with.


  [image: OOPS]


  Once you choose a game you are greeted with a menu of options down the left, and various bits of info about the chosen game. Selecting ‘Manage Game’ lets you choose a set of bindings for the controller.


  [image: OOPS]


  Some bindings are supplied by the developer of the game, but, if none are on offer, the community usually has at least one set of bindings available.


  [image: OOPS]


  It is good to have a choice of bindings. Of course, if you don’t like any of the settings on offer, you can create your own, or modify an existing setup.


  So, yeah, the Steam Link definitely works. It streams your desktop screen to your TV.


  Steam Controller


  The controller is actually quite nice. It has an analogue stick, and the pad on the right acts like a laptop touchpad. Handy for mouse games and such like. It has more than enough buttons (four on the front, four shoulder buttons, and two grip buttons on the back) with the inevitable Steam button slap bang in the middle which will turn the controller, and your Link, on/off.


  Updates can be sent to the controller via the supplied USB cable. Steam will pop up with a window telling you an update is available.


  
    Disclaimer: this review is very subjective. My taste in games dictates as to how effective the Link/Controller is in practice. Your choice in games may make my review completely void.
  


  In Practice


  The whole idea behind the Steam Link is to get your PC games on the big (TV) screen. To an extent it does, but not always. And sometimes when it does, it’s not great.


  So, some examples...


  Perfect Golf - Surely one of the perfect games for the Link and controller! Yes, but the developer doesn’t recognise the controller as yet, so this game is unplayable.


  Euro Truck Simulator 2 - Another one that would be excellent on the big screen, and in the comfort of your sofa. Well, this one does work! But at a price. Thus far, the only way I’ve managed to get it playable is by setting the control interface (in game) to keyboard then binding the relevant keys to the controller (or using an existing set of bindings and modifying them as necessary). Fine for most things, but terrible for driving. Which is what the game is about! Imagine driving in ETS2 using the keyboard. Not pleasant.


  ARK - This one is marked as being controller compatible, so that’s a good start! Well, it might work for most people, but for me, I get to see it working perfect on the PC, but on my TV screen I see some garbled green junk.
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  Starbound - This one does work perfectly. No gripes here. The developer provides a great set of key bindings.


  Cities: Skylines - A PC mouse and keyboard game if ever there was one, and the developer provides some good settings for it. I’m not saying it’s as good as, or better than, a mouse and keyboard, but it’s certainly playable.


  Conclusion


  So, you see, it’s a bit of a mixed bag. Maybe all your games will work great, and you’ll love the Link, but, as it stands, I can’t see how the Link is going to bring PC gaming to the living room TV.


  Yes, it’s great to be able to get in there and configure the layout to exactly how you like it with in depth controls, but, ideally, you want some preconfigured settings. Most games do, but some have none – and you’re on your own there.


  The Link is a good idea, and in hardware it works well, but, until the game developers get on board, it’s a bit of a hit-and-hope thing. Even in the Steam software there’s no way to know in advance, and for sure, if a game is compatible with the Link/Controller.


  Here’s hoping it improves with age.
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  Contribute to Full Circle Magazine

  FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles – and Full Circle is no exception. We need your opinions, desktops, stories, how-to’s, reviews, and anything else you want to tell your fellow *buntu users. Send your articles to: articles@fullcirclemagazine.org.

  

  We are always looking out for new articles to include in Full Circle. For help and advice, please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

  

  Send your comments or Linux experiences to: letters@fullcirclemagazine.org

  Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

  Questions for Q&A should go to: questions@fullcirclemagazine.org

  Desktop screens should be emailed to: misc@fullcirclemagazine.org

  ... or you can visit our forum via: www.fullcirclemagazine.org

  

  Full Circle Team:

  Editor - Ronnie Tucker - ronnie@fullcirclemagazine.org

  Webmaster - Lucas Westermann - admin@fullcirclemagazine.org

  Podcast - Les Pounder & Co. - podcast@fullcirclemagazine.org

  

  Editing & Proofreading:

  Mike Kennedy

  Lucas Westermann

  Gord Campbell

  Robert Orsino

  Josh Hertel

  Bert Jerred

  

  Our thanks go out to Canonical, to the many translation teams around the world, and to Thorsten Wilms for the current Full Circle logo.

  

  Getting Full Circle Magazine:

  

  EPUB Format - Most editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with the epub file, you can drop an email to: mobile@fullcirclemagazine.org

  

  Google Currents - Install the Google Currents app on your Android/Apple devices, search for 'full circle' (within the app), and you'll be able to add issues 55+. Or, you can click the links on the FCM download pages.

  

  Ubuntu Software Centre - You can get FCM via the Ubuntu Software Centre: https://apps.ubuntu.com/cat/. Search for 'full circle', choose an issue, and click the download button.

  

  Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to spread the word about FCM and Ubuntu Linux.
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VeraCrypt 1.13 Setup

VeraCrypt is a free disk encryption softuare brought to you by TORIX
(http://uuu. idrin.fr) and that is based on TrueCrypt.

It is a softuare systen for establishing and maintaining an
on-the-Fly-encrypted volure (data storage device). On-the-fly encryption
neans that data are automatically encrypted or decrypted right before they
are loaded or saved, without any user intervention. No data stored on an
encrypted volune can be read (decrypted) without using the correct
passuord/keyfile(s) or correct encryption keys. Entire file systen is
encrypted (e.g., file nanes, folder names, contents of every file,

free space, neta data, etc).

Please select one of the below options:

[Exit] [Extract -tar Package File] [Tnstall Veratrupt
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Installation Complete &

Installation has finished. You can continue testing Linux Mint now, but
until you restart the computer, any changes you make or documents
you save will not be preserved.
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